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Getting Instant Help

The help in Flow Charting 4 is context sensitive, making it easy to instantly display help about a specific 
menu command, dialog box, or Flow Charting 4 tool.

To find instant help on a... Do the following...
Menu command Highlight a menu command on a menu, and press F1.

Dialog box Display a dialog box, and click the Help button.

Flow Charting 4 error or warning Press F1.

Note: As you select menu commands, brief help messages automatically appear on the status bar at the 
bottom of a chart window. For more information, click Using the Status Line topic.



Mouse Shortcuts

Use the mouse buttons to do the following:

* When selecting text with the Text Tool, double-click to select a word.

* Hold down the Ctrl key and double-click a shape to display the CreateLink dialog box.

* Press the right mouse button to switch between the Selection tool and the last Insertion tool (Shape, 
Line, or Text). This is a shortcut for inserting several shapes or lines.

* Click the right mouse button to escape from zoom mode.



Keyboard Shortcuts

Flow Charting 4 provides keyboard accelerators for performing many basic flowcharting operations. You 
can use the keyboard accelerators to execute menu commands rather than choose the commands from 
the menus.

Tip: Choose Print Topic from the Help File menu to print the information on keyboard shortcut keys.

Shortcut Keys Action
Ctrl Hold down while you drag an object to toggle between snap and not snap to 

grid.

OR

Hold down while zooming to execute the Center Window command.

OR

Hold down and double-click a shape to display the CreateLink dialog box.

Shift Hold down while you resize a shape to toggle between keeping and not 
keeping the original shape proportions.

OR

Hold down while you drag a line end point to toggle between snapping and 
not snapping to an object.

OR

After you select the zoom in or zoom out button, press to toggle between 
zooming in and zooming out.

Alt Hold down while you resize a shape or text frame to toggle between 
reflective and normal resizing.

OR

Hold down and double-click after selecting a shape to toggle the shape 
between being connected and disconnected to adjoining lines.

Enter Press after highlighting an item in a drop-down list to select that item.

Esc Press to close a drop-down list without selecting an item.

Tool Manager Keys Action
F2 Select the ShapeManager button on the tool bar, and display the 

ShapeManager.

F3 Select the LineManager button on the tool bar, and display the LineManager.

F4 Select the TextManager button on the tool bar, and display the TextManager.

TextManager Keys Action
Ctrl+F Select the current font in the TextManager font name drop-down list.

Ctrl+H Select the current point size in the TextManager font size drop-down list.

Ctrl+B Turn the bold font style on or off.

Ctrl+I Turn the italic font style on or off.

Ctrl+U Turn the underlined font style on or off.

Ctrl+F9 Turn the superscript font style on or off.

Ctrl+F10 Turn the subscript font style on or off.



Ctrl+T Insert the current date and time.

Ctrl+N Insert the filename.

Shift+Up Arrow Select characters upward in existing text.

Shift+Down Arrow Select characters downward in the existing text.

Shift+Right Arrow Select characters to the right in existing text.

Shift+Left Arrow Select characters to the left in existing text.

Text Navigation Action
Up Arrow Move the text cursor up one line.

Down Arrow Move the text cursor down one line.

Left Arrow Move the text cursor left one character.

Right Arrow Move the text cursor right one character.

Ctrl+Left Arrow Move the text character left one word.

Ctrl+Right Arrow Move the text cursor right one word.

PageUp Move the text cursor up one paragraph.

PageDn Move the text cursor down one paragraph.

Home Move the text cursor to the beginning of the line.

End Move the text cursor to the end of the line.

Ctrl+Home Move the text cursor to the beginning of the continuous text (or press 
Ctrl+PgUp).

Ctrl+End Move the text cursor to the end of the continuous text (or press Ctrl+PgDn).



Setting Program Preferences
Program preferences are settings that help to determine how Flow Charting 4 works.

To change the program preferences:
1. Choose Program Preferences from the File menu.

The Program Preferences dialog box appears.

2. Make any changes you want, and click OK to accept the new settings, or click Cancel to abandon the 
changes..

Click the Dialog Box Options topic for more information.



Using Chart Windows
Each flowchart appears in a chart window. Click one of the following topics for more information on 
viewing a flowchart.

Arranging Chart Windows
Closing a Chart
Linking Charts
Opening a Chart
Opening a Chart from a Previous Version
Printing a Chart
Renaming a Chart
Saving a Chart
Scrolling a Window
Setting Chart Options
Starting a New Chart
Centering an Object in a Window
Using the Rulers
Zooming a Window



Centering an Object in a Window
The Center Window command allows you quickly to center a chart object in a window without having to 
use the scroll bars.

Note: This command has little effect near the top-left corner of the chart.

To center an object in a chart window:
1. Choose Center Window from the Window menu (or press Ctrl+W).

The cursor changes to a crosshair pointer enclosed in a circle.

2. Click the object you want to center.

To center an object in a chart window while in zoom mode:
1. Hold down the Ctrl key.

2. Click the object you want to center.

For more information on zoom mode, click the Zooming a Window topic.

Related Topics

Using Chart Windows



Arranging Chart Windows
If you are working with multiple charts, you can quickly arrange them for viewing on your screen.

To arrange chart windows:
1. Choose one of the following commands from the Windows menu:

* Tile Windows: to view all the windows on screen at the same time.

* Cascade Windows: to view all the window title bars, each window overlapping the other.

* Arrange Icons: to arrange the icons of minimized chart windows.

Related Topics

Using Chart Windows



Scrolling a Window
You can view different parts of the chart by moving the chart window using the scroll bars.

To scroll a chart window:
1. Click the scroll arrow buttons to move the flowchart. You can also drag the scroll box to scroll quickly 

through an entire chart.

To help speed up the scrolling, Flow Charting 4 uses SensibleScroll. which sketches the chart as you 
scroll. When you stop scrolling, the chart appears normal. For more information on SensibleScroll, click 
the Setting Program Preferences topic.

Note: If you press and hold a scroll arrow button for more than one second, the scrolling speed 
continuously increases and Flow Charting 4 uses SensibleScroll.

Related Topics

Using Chart Windows



Zooming a Window
Changing the magnification of a chart window is called zooming. You can use the zoom tools to magnify a
chart to see more detail, or to reduce a chart to see more pages and less detail. A chart can be magnified 
from 10 to 200 percent of its original size. The magnification of the current chart is shown on the status 
line at the bottom of the chart window.

To zoom a chart window:
1. Click one of the Zoom buttons on the tool bar.

Zoom In tool, to increase the magnification of the chart window, making objects appear 
larger. This tool is also available by choosing the menu item Window, then Zoom, then 
Zoom In.

Zoom Out tool, to reduce the magnification of the chart window, making objects appear 
smaller. This tool is also available by choosing the menu item Window, then Zoom, then Zoom In.

The pointer turns into a magnifying lens.

2. Each click in a chart window increases or decreases the magnification, and attempts to position the 
area or object you clicked in the center of the window. If you are zooming near the top, left of the 
chart, the area is not centered.

Note: You can press the Shift key to toggle between Zoom In and Zoom Out. You can press the Ctrl 
key to temporarily enable the center window tool. See Centering an Object in a Window.

3. To stop zooming, click the right mouse button, press Esc, or click the Selection Tool button.

To zoom using the keyboard:
1. To quickly increase or decrease the magnification without using a zoom tool, press the plus (+) or 

minus (-) key on the number key pad (the keys on the number pad are also referred to as gray keys).

If one or more objects are selected, the chart is scrolled so the center of the selected objects appear 
in the center of the window. If no objects are selected, the magnification changes, but the center of 
the window does not change.

Note: The keyboard zoom in and zoom out functions are not available while using the text tool.

Other zoom commands:
1. Choose Zoom from the Window menu; then choose one of the following commands from the Zoom 

submenu:

* Entire Chart: to reduce the chart so that all the pages in the chart are visible (or press Gray 
asterisk).

* Current Page: to reduce the size of the current page so that the entire page is visible (or press 
Ctrl+period).

* Actual Size: to display the chart at 100 percent magnification (or press Ctrl+equal sign).

Related Topics

Using Chart Windows



Using the Rulers
You can use rulers that appear at the top and left side of the chart window to help you place chart objects 
more accurately. If rulers do not appear on your chart window, refer to the Setting Program Preferences 
topic.

To use the rulers:
1. Drag the pointer or cursor tool over a chart page.

Marker lines appear on the ruler, telling you the current location of the pointer. Notice that marker 
lines appear on the top ruler as well as on the side ruler. You can use these marker lines to place an 
object accurately within the chart window.

Related Topics

Using Chart Windows



Using the Crosshairs
Crosshairs are special lines that extend the full length and width of the chart window; they appear much 
like crosshairs in a rifle scope. The crosshairs help you to align shapes relative to other shapes or to align
lines relative to other objects.

To use crosshairs:
1. Press and hold the spacebar while creating, moving, or resizing objects.

The crosshairs appear until you release the spacebar.

Related Topics

Aligning Objects



Using Flow Charting 4 on a Network
Flow Charting 4 supports networks in the following ways:

* If Flow Charting 4 has been installed on a network, several users can use the same copy of Flow 
Charting 4 at the same time.

* If Flow Charting 4 files are stored on a network, many users can view the same flowchart file at the 
same time. The first person to open a flow chart file can edit the information, but others who open the 
file can only view or print the contents. When you open a file that is being used by another person, the
name of the person editing the file appears in a dialog box. Click the topic Setting Program 
Preferences for more information about user name.

Note: See the Flow Charting 4 User's Guide for more information on installing and using Flow Charting 4 
on a network.



Using Templates
Flow Charting 4 comes with a set of predefined templates you can use to build your flowcharts. Click a 
shape in the template to select that shape to add to your flowchart. To move the template, drag the 
template by the title bar at the top of the template window. Click the Flow Charting 4 Window to view a 
sample template in a chart window.

Click one of the following topics for more information on templates:

Creating or Editing a Template
Hiding and Showing a Template
Opening a Template
Creating a New Shape



Creating or Editing a Template
If you need to arrange your shapes in several task-specific groups, or you need a special template 
containing the shapes you use most often, you can edit existing templates or create new templates that 
are comprised of the Flow Charting 4 shapes you choose.

To create a template:
1. If the template is not visible on screen, click the Template button on the tool bar.

2. Choose New from the Template menu (located on the template).

The Template Organizer dialog box appears. Click the Dialog Box Options topic for more information.

3. Choose a template from which to import shapes by clicking the Import button.

4. Click each desired shape in the Import Template box, and click the Insert button or the Append button 
to add the shape to the template.

5. Click the OK button to save the new template or click Cancel to abandon the changes.

The Save Template dialog box appears.

To edit a template:
1. If the template is not visible on screen, click the Template button on the tool bar.

2. Choose Edit from the Template menu (located on the template).

The Template Organizer dialog box appears. Click the Dialog Box Options topic for more information.

3. If you want to add shapes from another template, click the Import button.

Click each desired shape in the Import Template box, and click the Insert button or the Append button 
to add the shape to the current template.

4. If you want to remove shapes from the current template, click on the shape in the Current box; then 
click the Remove button.

5. Click the OK button to save the template or click Cancel to abandon the changes.

The Save Template dialog box appears.

Note: You can add shapes from one or more import templates before pressing the OK button.

Related Topics

Hiding and Showing a Template
Opening a Template



Hiding and Showing a Template
The template appears as a floating window on your screen.

To hide or show a template:
1. Click the Template button on the tool bar; the template appears on your screen. To hide the template, 

click the Template button again.

Tip: To close the Template window, double-click the Close box in the upper-left corner of the template 
window.

Related Topics

Using Templates



Opening a Template
Flow Charting 4 comes with a set of predefined templates from which you can choose the shapes you 
need for your flowchart.

To open a template:
1. If the template window is not visible on screen, click the Template button on the tool bar.

2. Choose Open from the Template menu (located on the template window).

The Open Template dialog box appears.

3. Select the template you want to open, and click OK.

Tip: The template menu lists the last five template files that were used. Choose a name from the menu to 
quickly open another template.

Related Topics

Using Templates



Using the Clipboard
The Windows Clipboard is a feature found in almost all Windows applications. It allows you to move 
information (such as lines, shapes, or text) within a flowchart, to another flowchart, or to another Windows
application file. Click one of the following topics for more information on using the Clipboard:

Copying and Pasting Graphics
Copying and Pasting Objects
Copying and Pasting Text
Using the Cut Command

Note: Information remains on the Clipboard until it is replaced by additional information copied to the 
Clipboard or until you exit Windows. For more information on using the Clipboard, refer to your Windows 
documentation.



Copying and Pasting Objects
You can copy flowchart objects (such as lines, shapes, or text) to the Windows Clipboard. Later, the 
objects can be pasted into Flow Charting 4 or any other application.

To copy objects:
1. Click the Selection Tool button on the tool bar.

2. Click the object you want to copy to the Clipboard.

To select more than one object, hold down the Shift key and continue to click different objects.

OR

Click and drag a selection rectangle around the objects you want to copy. Any objects completely 
inside the rectangle will be selected when you release the mouse button.

3. Choose Copy from the Edit menu.

The objects are copied to the Clipboard.

Note: When using the Selection Tool, text objects are copied to the clipboard as a metafile and a bitmap 
(not as a individual characters). These types of objects retain the font style, color, and formatting 
information of the text object. If you want to copy the text as individual characters, ignoring the style and 
formatting, use the Text tool. See the Copying and Pasting Text topic.

To paste objects:
To paste information to another chart file or application file, the file must be open, and it must be the 
active window.

1. Click the Selection Tool button on the tool bar.

2. Choose Paste from the Edit menu.

Related Topics

Using the Clipboard



Copying and Pasting Text
You use the Selection Tool or the Text tool to select text you want to copy to the Clipboard. If you want to 
copy and paste a text object, complete with font styles, colors, line width and line break information, use 
the Selection Tool. If you want to copy individual characters that will pasted into another text block or 
another application's text area, use the Text tool.

To copy text:
1. Click the Selection Tool button on the tool bar, and click a text object. The text object appears with a 

sizing handle at each corner.

OR

Click the Text tool button on the tool bar, and click any text in the flowchart. Drag to select the text 
characters you want to copy to the Clipboard.

Note: You must use the Text tool to select text typed into a shape.

2. Choose Copy from the Edit menu.

The information you selected is copied to the Clipboard.

To paste text:
To paste information to another chart file, you must have that file open, and it must be the active window. 
To paste to another application, the application's main window must be active.

1. If you used the Text tool to copy the text, click the Text tool button on the tool bar. Then click in a 
shape or text object where you want the text to appear. Click on an empty part of the chart to create a
new text object.

2. Choose Paste from the Edit menu.

If you used the Selection Tool, a new text object will be pasted in the center of the chart window. You 
can drag it to the desired location or resize it if necessary. If you used the Text tool, the text will be 
inserted into the current shape or text object.

Related Topics

Using the Clipboard
Creating a New Text Object



Copying and Pasting Graphics
You can paste any type of graphic from the Windows Clipboard into a flowchart. For example, you might 
create the graphic in a paint program and use the Windows Clipboard to transfer the graphic from the 
paint application to a flowchart.

To copy a graphic:
1. Select the graphic you want to copy to the Clipboard.

For more information on selecting a graphic in another application, refer to that application's user 
documentation.

2. Choose Copy from the Edit menu.

To paste a graphic:

1. Click where you want the graphic to appear.

2. Choose Paste from the Edit menu.

Related Topics

Using the Clipboard



Using the Cut Command
The Cut command allows you to remove text or objects from a flowchart and copy them to the Windows 
Clipboard.

To cut information to the Clipboard:
1. Select one or more objects in the chart using the Selection Tool, or select text using the Text tool. 

Click the Copying and Pasting Text topic for special instructions on copying and pasting text.

2. Choose Cut from the Edit menu or from the tool bar.

The information you selected is removed from the flowchart and copied to the Clipboard.

Related Topics

Copying and Pasting Objects
Copying and Pasting Text
Using the Clipboard



Flow Charting 4 Window
The Flow Charting main application window lets you work on up to nine charts at one time. Flow Charting 
4 supports Windows drag-and-drop functionality that allows you to drag chart file icons onto the 
application window to open the charts.

Click the flowchart window for a graphical definition of each window element.



Chart Window
This is the window where you create and edit flowcharts. If the window is maximized, it will almost fill the 
application window, and its title will be displayed in the application's title bar. If the chart window is not 
maximized, you can see other chart windows in this area.



Tool Bar
Displays tools to help you create a flow chart. If a tool is not available, it appears dimmed. For more 
information on the tools, click the The Tool Bar topic.



Title Bar
Displays the application name, Flow Charting 4. If the current chart window is maximized, its name will be
appended to the application name; otherwise, the chart's name will be in its own title bar. By default, each
new chart is called Untitled #n (where #n is a unique number for each new chart).



Menu Bar
Displays the Flow Charting 4 menus. You can choose menu commands to help you create, save, and 
print a flowchart. For more information, click the Menu Commands topic.



Tool Manager
Displays the current tool manager. There are three different tool managers: TextManager, LineManager, 
and ShapeManager. Each tool manager contains tools that allow you to set or edit the attributes of an 
object. For more information, click the Using the Tool Managers topic.



Template Window
Displays the shapes of the open template. You can use the shapes on a template to help you create a 
flowchart. For more information, click the Using Templates topic.



Status Line
Displays information about the current status of the chart window. For more information, click the Using 
the Status Line topic.



Using the Status Line
The status line appears at the bottom of each flowchart window and displays information about the 
flowchart.

Click the Status Line for more information.



The Context Cue
Provides brief descriptions or instructions on a selected menu command. The context cue can also give 
you instructions on how to proceed when you are creating a flowchart.



Chart Magnification
Displays the current magnification of the chart window. A chart can be magnified from 10 to 200 percent of
its original size. See Zooming a Window for more information on changing the magnification.



Insert or Overwrite Mode
Displays the current typing modeeither INS for insert mode or OVR for overwrite mode. In insert mode, 
additional text characters can be inserted before existing text. In overwrite mode, additional text 
characters overwrite text characters. Press the Ins key to toggle between insert and overwrite mode when
using the Text Tool.



Grid Mode
Displays the current grid mode. If the Snap to Grid setting is active, GRID appears. If this setting is not 
active, this box appears empty. Each object you insert into a chart is automatically snapped to an invisible
grid. When creating, moving, or resizing an object, hold down the Ctrl key to toggle this setting between 
snapping or not snapping to the grid. Click the Setting Program Preferences for information on the Snap 
to Grid setting.



Page Number
Displays the page number of the current chart. This value is updated as the mouse moves over each 
page.



The Tool Bar
The tool bar appears to the left of the chart window and contains tools to help you quickly create a 
flowchart.

Click a button on the Tool Bar for more information.



Tool Manager Button
Click the icons on the Tool Manager button to display another tool manager. This button appears only 
when more than one type of object is selected -- for example, when a line and shape are selected. Click 
the Selecting Objects topic for more information.



Selection Tool Button
Click the Selection Tool button to select objects in the flowchart. Click the Selecting Objects topic for more
information.



Shape Tool Button
Click the Shape tool button to add a shape to the flowchart. Click Creating a New Shape topic for more 
information.



Line Tool Button
Click the Line tool button to add a line to the flowchart. Click the Creating a New Line topic for more 
information.



Text Tool Button
Click the Text tool button to add or edit text in the flowchart. Click the Creating a New Text Object topic for
more information.



Template Button
Click the Template button to hide or show the template window. Click the Hiding and Showing a Template 
topic for more information.



Zoom Tools
Click the Zoom tools to magnify or reduce the chart window. Click the Zooming a Window topic for more 
information.

Shortcut: Holding the Ctrl key down while clicking Zoom In will zoom in to 100% magnification. Holding 
the Ctrl key down while clicking Zoom Out will zoom out to see the entire chart.



Open Button
Click the Open button to open a saved flowchart. Click the Opening a Chart topic for more information.

Shortcut: Holding the Ctrl key down while clicking the Open button will create a new chart.



Save Button
Click the Save button to save any changes to the current chart. If you have not previously saved the 
chart, the Save As dialog box appears. Click the Saving a Chart topic for more information.

Shortcut: Holding the Ctrl key down while clicking the Save button will activate the Save As feature, 
allowing you to rename the chart.



Print Button
Click the Print button to print the current chart to a Windows-compatible printer. Click the Printing a Chart 
topic for more information.

Shortcut: Holding the Ctrl key down while clicking the Print button will perform a quick print, bypassing 
the dialog that asks for print options. The entire chart, excluding blank pages, will be printed.



Undo Button
Click the Undo button to undo the previous action. Click the Undoing and Redoing Changes topic for 
more information. After an undo operation, clicking this button will perform the redo command.



Cut, Copy, and Paste Buttons
Click these buttons to cut, copy, and paste information using the Windows Clipboard. Click the Using the 
Clipboard topic for more information.

Shortcut: Holding the Ctrl key down while clicking the Cut button will perform the delete command. 
Holding the Ctrl key down while clicking the Copy button will perform the Copy to File command. Holding 
the Ctrl key down while clicking the Paste button will perform the Paste from File command.



Duplicate Button
Click the Duplicate button to duplicate the selected objects. Click Duplicating Objects topic for more 
information.



Reshape Line Button
Click the Reshape Line button to make a squared line take the shortest route between its two endpoints 
(without crossing over the objects that the line is attached to). Click the Reshaping Lines topic for more 
information.



Jump to Link Button
Click the Jump to Link button to display the chart and page to which an object is linked. Click the Linking 
Charts topic for more information.



Using the Tool Managers
The tool managers change according to the tool or object you select. If you are inserting new objects, the 
current tool manager will show the attributes of objects you are about to create. If you are using the 
Selection Tool, you can view the attributes of existing objects, or change them on the fly.

To view tool managers:
1. Click the appropriate tool on the tool bar to display a tool manager.

Click a tool button to display the associated tool manager.

 Text tool button

 Shape tool button

 Line tool button
The appropriate tool manager is displayed, and reflects the attributes of the next object created. Click 
the topic, Changing Attributes of New Objects for more information.

OR

Click the Selection Tool button and then select one or more objects of the appropriate type in a chart 
window.

 Selection Tool button

If more than one object is selected, the tool manager shows the attributes that the objects have in 
common. Any object attributes that are not shared by the selected objects appear as question marks 
or dimmed buttons on the tool manager.

Click the topic, Changing Attributes of Selected Objects for more information.

To change tool managers:
If you used the Selection Tool to select objects, and you would like to view a different tool manager:

1. Click the Tool Manager button until you see the appropriate tool manager. This button appears only 
when more than one type of object is selected.



Changing Attributes of Selected Objects
You can use the tool managers to change the attributes of any selected objects.

To change the attributes of selected objects:
1. Select an object.

The tool manager appears and displays the attributes for the selected object.

If more than one object is selected, the tool manager shows the attributes the objects have in 
common. Any object attributes that are not shared by the selected objects appear as question marks 
or as dimmed buttons on the tool manager.

Only one tool manager can be displayed at a time. If more than one type of object is selected (for 
example you selected a shape and a line) click the Tool Manager button to change which tool 
manager is displayed. You can also click the selected objects to display the other tool managers.

2. Change the attributes of the selected objects using the tool manager.

The selected objects appear with the new attributes.

Note: You can also change the attributes of selected text characters. Click the Text tool button, and then 
drag the cursor to select the text you want to change. Use the tools on the TextManager to change the 
text attributes.

Related Topics

Using the Tool Managers
Working with All Types of Objects



Changing Attributes of New Objects
You can use the tool managers to change the attributes of new objects.

To change the attributes of new objects:
1. Click either the Shape tool button, the Text tool button, or the Line tool button on the tool bar.

A tool manager appears at the top of the chart window that corresponds to the selected tool.

2. Use the tools on the tool manager to set the attributes of the new object.

3. If you are going to insert several objects of this type, click the Snapshot button to record these 
attributes. For more information, click the Using the Snapshot Button topic

4. Place the new object into the flowchart window.

Note: If you want a new object to have the same attributes as those of an existing object (for example, the
size and color of an object), select the object whose attributes you want to copy. Then, click the Snapshot 
button on the tool manager. The Snapshot button copies the attributes of the selected object. Each new 
object will have the same attributes. For more information, click the Using the Snapshot Button topic.

Related Topics

Using the Tool Managers
Working with All Types of Objects



Customizing the Tool Manager Colors
You can customize the colors that appear on the tool managers.

To customize the colors in the tool manager:
1. Double-click the color palette in the tool manager.

The Customize Colors dialog box appears.

2. Click the Color Palette square you want to change.

If you are changing the Shape pattern fill color palette, the color square with an X through it is for 
transparent color.

3. Click a Master Color on the palette.

The Color Palette square changes to match the Master Color you selected. Click the Dialog Box 
Options topic for more information.

4. Repeat steps 2 and 3 to change additional colors.

5. Click OK to accept the new palette or Cancel to reject it.

Note: To return the color palette to its factory-default settings, click Use Defaults.

Related Topics

Using the Tool Managers



Working with All Types of Objects
Flow charts are created using lines, shapes, and text; collectively, these items are called objects. For 
more information on objects, click one of the following topics:

Aligning Objects
Bringing to Front and Sending to Back
Changing Attributes of New Objects
Changing Attributes of Selected Objects
Copying and Pasting Objects to File
Deleting Objects
Duplicating Objects
Moving Objects
Reducing and Enlarging Objects
Resizing an Object
Selecting Objects
Using the Crosshairs
Using the Grid
Using the Snapshot Button



Aligning Objects
Flow Charting 4 can align objects to make your charts look neater.

To align objects:
1. Select two or more objects in a flowchart.

To select more than one object, hold down the Shift key while you click on objects.

2. Choose Align from the Actions menu.

3. From the Align submenu, choose how you want the objects aligned.

Align left edges - All objects will be aligned to the left edge of the object furthest to the left.

Align right edges - All objects will be aligned to the right edge of the object furthest to the right.

Align column - The centers of all objects will be aligned to the center of the imaginary rectangle 
that surrounds all of the objects.

Align top edges - All objects will be aligned in a column to the top edge of the object furthest to 
the top.

Align bottom edges - All objects will be aligned to the bottom edge of the object furthest to the 
bottom.

Align row - The centers of all objects will be aligned in a row to the center of the imaginary 
rectangle that surrounds all of the objects.

Related Topics

Working with All Types of Objects



Moving Objects
When you need to arrange the objects in your chart, you can use the Selection Tool to select as many 
objects as desired, and then move them to a new location. If the Stick-to-objects option is enabled in the 
Program Preferences, lines attached to the objects will be moved automatically.

To move objects:
1. Click the Selection Tool button and select one or more objects.

2. Position the mouse pointer over any selected object, then hold down the mouse button and drag the 
object to a new location.

The crosshair can be used to help align the object you dragged. Simply press the spacebar to see the
crosshair.

To use sticky lines:
If the stick-to-objects option in the Program Preferences dialog is enabled, attached, or connected 
lines will automatically be repositioned and adjusted after the move. Hold the Alt key (or A key) down 
any time before releasing the mouse button to temporarily reverse the state of this option. If the option
is enabled, the Alt key (or A key) will turn off stickiness. If the option is disabled, the Alt key (or A key) 
will turn on stickiness.

Here is an example of a line attached, or connected to a shape. Attachment points are shown as 
small circular handles instead of square handles.

Note: Lines are not attached to another object unless you specifically connect them. See Connecting 
Lines to Other Objects for more information.

Related Topics

Connecting Lines to Other Objects
Selecting Objects
Using the Crosshairs
Setting Program Preferences



Using the Grid
Whenever you add or resize a shape, line, or text object, the object is placed on an invisible grid. The grid
makes it easier to align your objects, resulting in a neater looking chart. The grid can be turned on and off 
using the Program Preferences dialog box. You can also toggle the grid setting on and off using the Ctrl 
key.

If the grid is enabled, it will be used when placing new objects, when moving objects, and when resizing 
objects. You can see the current state of the grid on the Status Line.

Related Topics

Setting Program Preferences



Bringing to Front and Sending to Back
Shapes, text, and lines can be placed on top of each other. You can use menu commands to move 
objects that overlap each other, bringing them to the top or sending them to the bottom.

To bring an object to the front:
1. Using the Selection Tool, click one or more objects to select them.

2. Choose Bring to Front from the Actions menu.

Here is an example of overlapping objects:

Before After

To send an object to the back:
1. Using the Selection Tool, click one or more objects to select them.

2. Choose Send to Back from the Actions menu.

Here is an example of overlapping objects:

Before After

Related Topics

Working with All Types of Objects



Deleting Objects
You can quickly delete text, shapes, or lines from your flowchart using either a keyboard or menu 
command.

To delete objects:
1. Select the object or objects you want to delete.

2. Choose Delete from the Actions menu.

OR

Press the Delete key on your keyboard.

OR

Hold the Ctrl key down while clicking the Cut button on the tool bar.

Related Topics

Selecting Objects



Duplicating Objects
You can quickly duplicate objects in your flowchart. When you duplicate an object, Flow Charting 4 
remembers the relative position of the object that has been copied. Thus, you can use the duplicate tool 
to create rows or columns of objects that are evenly spaced.

To duplicate objects:
1. Select the objects you want to duplicate.

2. Choose Duplicate from the Edit menu.

OR

Press Ctrl+D

OR

Click the Duplicate button on the tool bar.

Related Topics

Selecting Objects



Working with Lines
You use lines to connect the shapes in your flowchart. Click one of the following topics for more 
information on working with lines:

Adding and Removing Bypasses
Adding and Removing Points
Changing a Line's Color
Changing a Line's Endcaps
Changing a Line's Path Type
Changing a Line's Route
Changing a Line's Style and Thickness
Connecting Lines to Objects
Creating a New Line
Disconnecting Lines from Objects
Reshaping Lines



Reshaping Lines
When a sqared line has been moved, it may contain unecessary turns that you would like to remove. 
Reshaping a line will hammer out the unecessary bends, and change the line to take the shortest route 
between its starting point and ending point. If the end points of a line are attached to shapes, the line will 
automatically avoid the shapes.

To reshape a line:
1. Select one or more lines, or shapes that have attached lines.

2. Select Reshape Lines from the Actions menu.

OR

 Click the Reshape button on the tool bar.
3. If the line crosses over other objects after reshaping it, you can change its route manually.

Note: Reshaping a line will remove all of its bypasses.

Related Topics

Changing a Line's Route



Adding and Removing Bypasses
If two lines in a chart intersect each other, you can add a bypass to one of the lines. A bypass is a special 
flowcharting symbol that shows where lines in the flowchart cross.

To add a bypass:
1. Select the line to which you want to add a bypass.

The LineManager appears.

2. Click the Add Bypass button  on the LineManager.

The mouse pointer now includes a bypass shape.

3. Click the point of the cursor exactly where you want to add the bypass to the line.

To remove a bypass:

1. Select the line from which you want to remove a bypass.

The LineManager appears.

2. Click the Remove Bypass button  on the LineManager.

3. Click the point of the cursor on the bypass you want to remove.

To remove all bypasses:
1. Reshape the line.

Related Topics

Working with Lines
Reshaping Lines



Adding and Removing Points
You can use the tools on the LineManager to add points to or remove points from lines. Repositioning 
points on a line, or adding or deleting them are powerful ways to control the exact route of a line.

To add a point:
1. Select the line to which you want to add points.

Note: A curved line can contain a maximum of four points.

The LineManager appears.

2. Click the Add Points button  on the LineManager.

The mouse pointer now includes a plus (+) sign.

3. Position the mouse pointer at the place on the line where you want to add the point, and click.

OR

Click close to an end point of the line to extend the line.

Note: You can also add a point to squared lines by dragging any of the points after the line is 
selected. Watch the outline as you drag the point until you get the desired path and then release the 
mouse button.

To remove a point:
1. Select the line from which you want to remove points.

Note: You cannot remove corner points on a squared line.

The LineManager appears.

2. Click the Remove Points button  on the LineManager.

The mouse pointer now includes a minus (-) sign.

3. Position the cursor over the point you want to remove, and click.

Note: As long as the point you want to remove is not a corner point of a squared line, you can remove it 
by dragging it on top of another point.

Related Topics

Working with Lines



Changing a Line's Color
You can change the color of a line in your flowchart. You can choose from the colors on the LineManager 
palette or from colors on the Customize Color dialog box.

To change a line's color:
1. Select a line in your flowchart.

The LineManager appears.

2. Click a color in the Color Palette on the LineManager.

Note: For directions on how to edit the color palette, click the Customizing the Colors topic.

Related Topics

Using the Snapshot Button
Working with Lines



Changing a Line's Endcaps
Endcaps appear at the ends of each line in your flowchart. You can select the endcaps you want to 
appear by choosing from the endcap drop-down lists on the LineManager.

To change a line's endcaps:
1. Select a line in your flowchart.

The LineManager appears.

2. Choose for the endcap for the first point in the line from the left endcap drop-down list and choose the
endcap for the last point in the line from the right endcap drop-down list.

Note: You can also edit or rearrange the line endcap drop-down lists using the Program Preferences 
dialog box. For more information, click the Setting Program Preferences topic.

Related Topics

Using the Snapshot Button
Working with Lines



Changing a Line's Path Type
You can change a line's path type to accommodate a special situation in your flowchart. There are three 
different types of lines you can use in your flowchart: free-angle, squared, and curved.

To change a line's path type:
1. Select a line in your flowchart.

The LineManager appears.

2. Click a Line path button on the LineManager.

 Free Angle button

 Squared Angle button

 Curved Angle button

Related Topics

Using the Snapshot Button
Working with Lines



Changing a Line's Route
You can change the route of a line by moving a line's points.

To change a line's route:
1. Select a line.

When you select a line, all the points at the segment endings are visible. Click the Adding and 
Removing Points topic for information on adding points to a line.

2. Position the cursor over a handle; then hold down the mouse button and drag the point to a new 
location.

In some cases, the type of line path will determine how much you can modify a line's route. Click the 
Changing a Line's Path Type topic for more information.

Note: Lines can be attached to shapes or other lines by dragging an end point onto the object. If the 
program preference, stick-to-objects is enabled, attached lines move with an object when the object 
moves. When an endpoint is attached to another object, a circle handle is drawn instead of a square 
handle.

Related Topics

Working with Lines
Reshaping Lines
Connecting Lines to Objects



Changing a Line's Style and Thickness
You can change a line's style and thickness.

To change a line's style and thickness:
1. Select a line.

The LineManager appears.

2. Select a line style from the Line Style drop-down list.

Related Topics

Using the Snapshot Button
Working with Lines



Connecting Lines to Objects
You can connect lines to shapes or other lines. Later, if the stick-to-objects program preference is 
enabled, the line will be moved whenever the connected object moves.

When an endpoint is connected to another object, a circular handle is drawn instead of a square handle.

To connect lines to shapes:
If lines are touching a shape but not connected:

1. Select the shape near the line to which you want to connect.

2. Choose Connect Adjoining Lines from the Actions menu.

OR

Drag the end point of a line inside a shape. The line will automatically snap to the edge of the shape 
and be connected. You can also make sure a line is connected to a shape when you create the line. 
Make sure to click somewhere inside the shape to connect it.

To connect lines to lines:
1. Select the line that is not connected.

2. Drag the end point onto the line.

Related Topics

Setting Program Preferences
Working with Lines



Disconnecting Lines from Objects
Sometimes you need to disconnect lines to move their attached shapes without moving the lines as well.

To disconnect lines from other objects:
1. Select the object with a connected line that you want to disconnect.

2. Choose Disconnect Lines from the Actions menu.

OR

If the stick-to-objects option in the Program Preferences dialog box is disabled, simply moving the 
attached object will disconnect the line. If the stick-to-objects option is enabled, hold down the Alt key 
while you move the object, and the attached lines will be disconnected.

Related Topics

Setting Program Preferences
Working with Lines



Creating a New Line
You can create new lines to use in your flowchart.

To create a line:
1. Click the Line tool button on the tool bar.

The LineManager appears.

2. Change attributes in the LineManager if needed.

Note: Use the Snapshot tool if you are inserting several lines of the same type so you won't have to 
continuously choose the new attributes. You can also use the Snapshot tool to memorize the 
attributes of existing objects in the chart using the Selection Tool.

3. Click where you want the line to begin. Click for each additional point.

4. Double-click when finished.

OR

Click the same point twice.

OR

Press the Esc key.

OR

Click inside a shape to finish and snap the line to the edge of the shape. This will attach, or connect 
the line to the shape. Attached lines will remain attached to the shape when the shape moves if the 
Program Preferences option, Stick to objects, is enabled. See Setting Program Preferences.

Note: If you don't want to snap the line to the edge of a shape, hold down the Shift key. This will 
toggle the snap-to-objects option of the Program Preferences dialog.

Squared lines:
Each point that you add to a squared line will be constrained to 90 degree bends. Additionally, 
squared lines will intelligently add appropriate turns when entering a shape or connecting to another 
line. Simply move the mouse pointer into an edge of the shape or onto another line before clicking.

Curved lines:
Curved lines can have a maximum of four points. The first and the last point are used to place the 
line, the other points are used to control the curvature.

Free-angled lines:
Free-angled lines have no restrictions to their angles, nor number of points.

Related Topics

Setting Program Preferences
Using the Snapshot Button
Using the Crosshairs
Using the Grid
Working with Lines



Using the Snapshot Button
The Snapshot button records the attributes currently displayed in the tool manager. You can snapshot 
attributes of new objects you are creating, or of existing objects you select using the Selection Tool. When
you snapshot the attributes of a tool manager, the attributes will be used for all new objects subsequently 
created.

Note: When using the Selection Tool, the dimensions of a selected text object and shape are also 
recorded. The word-wrap width of a selected text object is recorded, and the width and height of a shape 
are recorded (each shape type can have unique dimensions recorded).

To use Snapshot:
1. Click the Selection Tool, Shape Tool, Line Tool, or Text Tool.

2a. If you use the Selection Tool, select one object of the type you wish to snapshot.

If the desired tool manager is not displayed, click the Tool Manager button.

2b If you use the Text Tool, you can select one or more characters to snapshot. Only the attributes that 
are common to all selected characters will be recorded.

3. Click the Snapshot tool on the tool manager.

The attributes are recorded as defaults. Each time you create a new object, it uses the default 
attributes to adjust its size, color, and so on.

Note: You can use the Snapshot tool to make all the shapes in your flowchart the same size. For more 
information, click the Making a Shape's Size Consistent topic.

Related Topics

Selecting Objects
Selecting Text



Working with Shapes
Click one of the following topics for more information on using flowcharting shapes:

Changing a Shape Type
Changing a Shape's Border Thickness
Changing a Shape's Color
Changing a Shape's Fill Pattern
Creating a New Shape
Deleting Text from a Shape
Making a Shape's Size Consistent



Changing a Shape's Border Thickness
You can change the thickness of a shape's border.

To change a shape's border thickness:
1. Select the shape.

The ShapeManager appears at the top of the chart window.

2. Click one of the Shape Border tool buttons on the ShapeManager.

Related Topics

Using the Snapshot Button
Working with Shapes



Changing a Shape's Color
You can change the border thickness of any shape in your flowchart.

To change a shape's color:
1. Select the shape.

The ShapeManager appears at the top of the chart window.

2. Click a color on the Shape Color Palette on the ShapeManager.

You can customize the colors that appear on the palette. For more information, click the Customizing 
the Tool Manager Colors topic.

Related Topics

Using the Snapshot Button
Working with Shapes



Changing a Shape's Fill Pattern
You can change a shape's fill pattern for any shape in your flowchart.

To change a shape's fill pattern:
1. Select the shape.

The ShapeManager appears at the top of the chart window.

2. Select a fill pattern from the Fill pattern drop-down list on the ShapeManager.

If you choose the color on the palette that has an X through it, the shape will not have any color and 
will be transparent. To move a transparent shape, you must drag the shape by its border.

Note: You can customize the colors that appear on the palette. For more information, click the 
Customizing the Tool Manager Colors topic.

Related Topics

Using the Snapshot Button
Working with Shapes



Changing a Shape Type
You can change any shape in your flowchart.

To change a shape:
1. Select the shape.

The ShapeManager appears at the top of the chart window.

2. Select a shape from the Shape drop-down list located on the ShapeManager.

Note: You can use the Snapshot tool to create a default set of attributes for each shape. To create a 
default set of attributes, select a shape in your flowchart, and then click the Snapshot button on the 
ShapeManager. For more information, click the Using the Snapshot Button topic.

Related Topics

Working with Shapes



Creating a New Shape
You can add new shapes to your flowchart.

To create a new shape:
1. Click a Shape button on the Template window. If the Template window is not visible, click the 

Template button.

OR

Click the Shape tool button on the tool bar. Then select a shape from the Shape drop-down list on the
ShapeManager.

2. Set the attributes of the shape using the tools on the ShapeManager.

Note: See Using the Snapshot Button if you are inserting several shapes of the same type so you 
won't have to continuously choose the new attributes. You can also use the Snapshot tool to 
memorize the attributes of existing shapes in the chart using the Selection Tool.

3. Position the cursor where you want the shape placed in your flowchart, and click.

Note: Each unique shape type records its own dimensions separately when you use the Snapshot tool. 
This allows you to keep your shapes consistent, with diamonds one size, and squares another size. Click 
the topic, Making a Shape's Size Consistent.

Related Topics

Using the Snapshot Button
Working with Shapes



Deleting Text from a Shape
You can use the Text Tool to delete some of the text in a shape, or the Selection Tool to delete all of the 
text.

To delete text with the Text Tool:
1. Click the Text tool button on the tool bar.

2. Highlight the text you want to delete. See Selecting Text.

3. Press the Delete key.

OR

Choose Delete from the Edit menu.

To delete text with the Selection Tool:
1. Click the Selection Tool button

2. Select the shape by clicking it.

3. Choose Clear Shape Text from the Actions Menu

All of the text will be deleted from the shape.

Related Topics

Working with Shapes



Making a Shape's Size Consistent
You can adjust the size of the shapes in your flowchart. Later, you may decide that you want all shapes to
have the same size. For example, you might have a series of square shapes that you want to make the 
same size. Flow Charting 4 gives you a quick way to adjust the size of a series of shapes.

To make a shape's size consistent:
1. Select a shape that is the size you want to apply to other shapes.

The ShapeManager appears.

2. Click the Snapshot button.

3. Select the other shapes in your flowchart.

One way to select multiple shapes is to hold down the Shift key, and continue to click the other 
shapes.

4. Select the same shape from the Shape drop-down list on the ShapeManager.

For example, if your are adjusting the sizes of all the squares in your flowchart, select the square 
shape from the drop-down list. All squares will be reset to the size of the default square, the one that 
was snapshotted last.

Related Topics

Using the Snapshot Button
Working with Shapes



Working with Text
You can add text to fit within a shape or anywhere on your flowchart. Click one of the following topics for 
more information on adding and editing text:

Changing the Text Background
Changing the Text Color
Changing the Text Font
Changing the Text Justification
Changing the Text Size
Changing the Text Styles
Copying and Pasting Text
Creating a New Text Object
Deleting Text from a Shape
Inserting the Date, Time, or File Name
Selecting Text
Using Insert/Overwrite Mode



Changing the Text Background
You can make the text background white, obscuring any objects behind the text, or you can make the text
background transparent.

To change the text background:
1. Select the text you want to change.

You can use either the Selection Tool or the Text tool to select text. For more information, click the 
Selecting Text topic.

2. Click the Text Background button on the TextManager to toggle between white and transparent text 
backgrounds.

Note: The text object must be in front of other objects for this feature to work. For more information, click 
the Bringing to Front and Sending to Back topic.

Related Topics

Using the Snapshot Button
Working with Text



Changing the Text Color
You can change the color of any text in your flowchart.

To change the text color:
1. Select the text you want to change.

You can use either the Selection Tool or the Text tool to select text. For more information, click the 
Selecting Text topic.

2. Click a color in the Text Color Palette located on the TextManager.

The text changes to match the color you selected.

Note: You can customize the colors that appear on the palette. For more information, click the 
Customizing the Tool Manager Colors topic.

Related Topics

Using the Snapshot Button
Selecting Text
Working with Text



Changing the Text Font
You can change the font of any text in your chart; you can choose from fonts that have been installed 
using Windows. Refer to your Windows documentation for more information on installing fonts.

To change the text font:
1. Select the text you want to change.

You can use either the Selection Tool or the Text tool to select text. For more information, click the 
Selecting Text topic.

2. Select another font from the Font drop-down list on the TextManager.

Related Topics

Using the Snapshot Button
Working with Text



Changing the Text Justification
You can change the alignment of the text in your flowchart.

To change the font justification:
1. Select the text you want to change.

You can use either the Selection Tool or the Text tool to select text. For more information, click the 
Selecting Text topic.

2. Click the Font Alignment buttons located on the TextManager.

Related Topics

Using the Snapshot Button
Working with Text



Changing the Text Size
You can change the text point size of any text in your flowchart.

To change the text size:
1. Select the text you want to change.

You can use either the Selection Tool or the Text tool to select text. For more information, click the 
Selecting Text topic.

2. Select a font size from the Font Size drop-down list located on the TextManager.

Related Topics:

Using the Snapshot Button
Working with Text



Changing the Text Styles
You can change the text style of any text in your flowchart.

To change text styles:
1. Select the text you want to change.

You can use either the Selection Tool or the Text tool to select text. For more information, click the 
Selecting Text topic.

2. Click the Bold, Italic, Underline, Subscript or Superscript text style button located on the TextManager.

Related Topics

Using the Snapshot Button
Working with Text



Creating a New Text Object
You can create new text objects for your flowchart.

To create a new text object:
1. Click the Text tool button located on the tool bar.

The cursor changes to a bar (|) cursor.

2. Set the text attributes using the TextManager.

Note: Use the Snapshot tool if you are inserting several text objects of the same type so you won't 
have to continuously choose the new attributes. You can also use the Snapshot tool to memorize the 
attributes of existing text in the chart using the Selection Tool or the Text Tool.

3. Click the flowchart where you want to begin typing.

4. Type any text you want to appear.

You can also click inside a shape, and any text you type is automatically connected to the shape.

Note: The Snapshot tool will also memorize the word-wrap width of a text object. If you are inserting 
several notes in 3 inch columns, snapshot the first one, and the width will be recorded.

Related Topics

Working with Text
Using the Snapshot Button



Inserting the Date, Time, or File Name
To help keep revision information, you can insert the current time, date, or filename in any shape or text 
object, using any font size or style you like.

1. Click the Text tool button located on the tool bar.

The cursor changes to a bar (|) cursor.

2. Click the flowchart where you want to insert the time, date, or file name.

3. Press Ctrl+T to insert the time and date.

The Insert Date/Time dialog box appears. Select the date or time you want to insert into the flowchart,
and click OK.

OR

Press Ctrl+N to insert the file name of the current flowchart.

Note: You can change the Time and Date formats using the Windows Control Panel. Select the 
International Control Panel, and click the Date Format Change button or the Time Format Change button. 
Refer to your Windows documentation for more information.



Using Insert/Overwrite Mode
You can change the text mode to insert or overwrite. In Insert mode, new text is inserted without 
overwriting any existing text characters. In Overwrite mode, new text overwrites any existing text 
characters.

To use Insert/Overwrite mode:
1. Click the Text tool button located on the tool bar.

2. Click where you want to insert the new text.

3. Press the Insert key to switch to Insert mode.

OR

Press the Insert key again to switch to Overwrite mode. The Insert key toggles between the two 
modes.

The Status line at the bottom of the chart window displays the current mode; OVR appears when in 
Overwrite mode, and INS appears in Insert mode.

Related Topics

Working with Text



Selecting Text
There are two ways to select text.

To select text inside a shape:
1. Click the Text tool button on the tool bar; then drag the text pointer across the text you want to select.

OR

Click the Selection Tool button on the tool bar; then click the shape containing the text you want to 
select. Click the Tool Manager button to display the TextManager.

To select a text object:
1. Click the Text tool button on the tool bar; then drag the text pointer across the text you want to select.

OR

Click the Selection Tool button on the tool bar; then click the text object containing the text you want 
to select. All the text in the object will be selected

Note: If more than one character is typed, the TextManager may show indeterminate attributes. In other 
words, if one character is red, and another black, the color box will show a question mark because two 
colors cannot be shown at the same time. If you change an indeterminate attribute, you will change all 
characters to that new attribute.

Related Topics

Working with Text



Copying and Pasting Objects to a File
You can copy selected objects from a flowchart and save the information permanently to a file. Later, you 
can paste the information from the file into any flowchart. For example, you might create a special 
flowchart symbol that you want to be able to paste into many different flowcharts. Click one of the 
following topics for more information.

Note: Files that are used for copying and pasting have a file extension of GFI (graphic flowcharting 
image).

Copying To a File
Pasting From a File



Copying to a File
You can copy selected objects to a file.

To copy selected objects to a file:

1. Select the objects you want to copy.

2. Choose Copy to File from the Edit menu.

The Copy to File dialog box appears.

4. Name the file, and click OK.

Click the Dialog Box Options topic for more information.

Related Topics

Pasting From a File



Pasting from a File
You can paste selected objects saved to a file into any flowchart.

To paste selected objects from a file:
1. Choose Copy from File from the Edit menu.

The Copy from File dialog box appears.

2. Choose the file you want to paste into your flowchart, and click OK.

Click the Dialog Box Options topic for more information.

Related Topics

Copying To a File



Resizing an Object
You can resize an object by selecting it and dragging a sizing handle. You can resize shapes, text objects,
bitmaps, and metafiles this way. The selection handles of a line are not used to resize a line, rather they 
are used to change the path of the line.

When resizing, some shapes maintain the same width to height ratio (for instance, a circle or a computer 
symbol); this is called proportional resizing. Other shapes let you make them very wide or very tall (for 
instance, most flowcharting symbols); this is called non-proportional resizing. You can easily switch the 
proportional resizing behavior while resizing any type of object.

There are two more special behaviors under your control while resizing objects. You can keep the object's
edges from snapping to the grid, and you can reflectively resize objects to make them grow or shrink in 
two directions at once (for example, the top and bottom edges moving simultaneously). Both of these 
behaviors can be permanently set by the Program Preferences dialog. Click the Setting Program 
Preferences topic.

To resize an object:
1. Using the Selection Tool, select the object you want to resize.

2. Drag a sizing handle until the object is the appropriate size.

You can see the size (and sometimes the scale) of an object on the Status Line while resizing.

3. Release the mouse button.

To switch reflective resizing
1. Hold down the Alt key while resizing. Release the mouse button before you release the Alt key.

To switch proportional resizing:
1. Hold down the Shift key while resizing the shape. Release the mouse button before you release the 

Shift key.

Note: If you do not have reflective resizing permanently enabled, you should consider resizing an object 
by a multiple of two grid units. This will insure that the center of the object remains on a grid. If you later 
move an object that has its center off of a grid, the object's center will be snapped to the grid (resulting in 
the edges moving off of the grid). Keeping both the center and the edges on a grid makes it much easier 
to align objects, and to neatly connect lines.

Related Topics

Setting Program Preferences
Using the Crosshairs
Using the Grid



Reducing and Enlarging Objects
You can quickly scale a group of objects to 80 percent of their original size or to 125 percent of their 
original size. This feature is especially useful if you are trying to fit a flowchart onto a single page.

To reduce or enlarge objects:
1. Select the objects.

2. Choose Scale Selection - 80% from the Actions menu to reduce the selected objects to 80 percent of 
their original size.

OR

Choose Scale Selection - 125% from the Actions menu to enlarge the selected objects to 125 percent
of their original size.

Note: An object can be scaled at 80 percent or 125 percent because these proportions are reversible. An 
object scaled to 80 percent can be returned to its original size by scaling the object to 125 percent; the 
reverse of this is also true.

Related Topics

Working with All Types of Objects



Selecting Objects
There are several ways to select objects in a flow chart for editing.

To select an object for editing:
1. Click the Selection Tool button on the tool bar. Then, click an object to select it. To select more than 

one object, hold down the Shift key and continue to click objects.

OR

Click the Selection Tool button on the tool bar. Drag the cursor around the objects you want to select. 
As you drag the cursor, a dotted square line appears around the objects. Any objects wholly within the
dotted lines are selected.

OR

Choose Select All from the Edit menu (or press Ctrl+/). All the objects in the flowchart are selected.

A tool manager appears at the top of the chart window after you select an object. You can use the tool 
managers to change the attributes of the selected objects. If you selected more than one type of object 
(for example, you selected a line and shape), click the Tool Manager button button to display the tool 
manager for the selected object.

If you selected several objects that do not share the same attributes, the tool manager displays question 
marks. For example, if you selected three shapes with different fill patterns, the ShapeManager will 
display a question mark for the fill pattern. To change the ambiguous attribute (an attribute displaying a 
question mark), select an attribute.

Related Topics

Working with All Types of Objects



Undoing and Redoing Changes
If you make a mistake, you can undo the last action. After an undo, you can still decide to redo the action.

To undo an action:
1. Choose Undo from the Edit menu, or click the Undo button on the tool bar.

The last action you performed is undone.

To redo an action:
1. Choose Redo from the Edit menu, or click the Undo button on the tool bar.

The previous action is performed again.

Note: The Redo command is available only after you choose Undo.

Related Topics

Working with All Types of Objects
The Tool Bar



Closing a Chart
There are several ways to close a flowchart.

To close a chart:
1. Choose Close from the File menu.

OR

Press Ctrl+F4.

OR

Choose Close from the chart window control menu in the upper-left corner of the window.

If you have made any changes to the chart, you are prompted to save the changes before the chart 
closes.

Related Topics

Using Chart Windows



Opening a Chart
You can open a saved chart file.

To open a chart:
1. Choose Open from the File menu, or click the Open button on the tool bar.

The Open dialog box appears.

2. Select the chart you want to open, and click OK.

Click the Dialog Box Options topic for more information.

Note: You can have more than one flowchart open at the same time. To switch between open charts, 
choose from the list of open chart files at the bottom of the Window menu.

Related Topics

Opening a Chart from a Previous Version
The Tool Bar
Using Chart Windows



Opening a Chart from a Previous Version
You can open a chart created in a previous version of Flow Charting. Supported versions are Flow 
Charting I, II, II+, and 3, as well as images.

To open a flowchart created in a previous version:
1. Choose Open from the File menu, or click the Open button on the tool bar.

The Open dialog box appears.

2. Select the Flow Charting file type from the List Files of Type drop-down list.

3. Select the chart you want to open

4. Click OK.

Click the Dialog Box Options topic for more information.

Once you have selected the file, the older chart will be converted automatically and be stored in a new, 
untitled window. The progress of the conversion is displayed in the Status Line.

Note: Because Windows does not support hollow lines at this time, hollow lines will be converted into 
regular lines.

Related Topics

The Tool Bar
Using Chart Windows



Printing a Chart
You can print a flowchart to a Windows-compatible printer.

To print a chart:
1. Choose Print from the File menu, or click the Print button on the tool bar.

The Print dialog box appears.

Shortcut: If you hold down the Ctrl key when you click the Print button, a dialog will not appear, and 
all non-blank pages of the chart will be printed.

2. Click the Dialog Box Options topic for more information.

Note: For more information on Windows-compatible printers, refer to your Windows documentation. 
Unfortunately, many Windows plotter drivers may not support shapes that are overlapped, or other effects
that are standard for raster devices.

Related Topics

The Tool Bar
Using Chart Windows



Renaming a Chart
You can rename a flowchart to a different file name.

To rename a chart file:
1. Choose Save As from the File menu, or Ctrl+click the Save button on the tool bar.

The Save As dialog box appears. Click the Dialog Box Options topic for more information.

2. Rename the chart file, and click OK.

Related Topics

The Tool Bar
Using Chart Windows



Saving a Chart
You can save a chart to disk.

To save a chart file:
1. Choose Save from the File menu, or click the Save button on the tool bar.

Any changes are saved to the current chart file. If you have not previously saved the file, the Save As 
dialog box appears. Name the file, and click OK. Click the Renaming a Chart topic for more 
information.

Related Topics

The Tool Bar
Using Chart Windows



Setting Chart Options
You can set the chart options for each flowchart, such as the number of chart pages, chart margins, paper
size, and so on.

Note: This command replaces the Print Setup command found in most applications because you can 
specify that the default printer or a specific printer should always be used with each of your charts. Flow 
Charting 4 warns you when you try to set up or print a chart that was formatted with a different printer 
because it can affect page sizes.

To set the chart options:
1. Click the chart window you wish to configure.

This makes it the active window.

2. Choose Chart Setup from the File menu.

The Chart Setup dialog box appears. Click the Dialog Box Options topic for more information.

3. Select the chart settings, and click OK

Related Topics

Using Chart Windows



Starting a New Chart
You can start a new flowchart at any time.

To start a new chart:
1. Choose New from the File menu, or Ctrl+click the Open button on the tool bar.

A blank, untitled flowchart window appears.

Note: Only nine chart windows may be open at any one time.

Related Topics

The Tool Bar
Using Chart Windows



Linking Charts
Flow Charting 4 lets you link an object to a page in any flowchart. This allows you to jump to another page
in the same chart or in a different chart.

To create a link:
1. Open the chart for which you want to create the link.

2. Select the specific object in the chart where you want to create the link.

Click the Selecting Objects topic for more information.

3. Choose Create Link from the links menu.

OR

Hold down the Ctrl key while you double-click the object.

The CreateLink dialog box appears.

4. Choose the file to which you want to link the object.

5. Type a page number, and then click OK.

Click Dialog Box Options for more information.

To jump to a linked chart:
1. Select the object.

2. Click the Jump to Link tool button on the tool bar.

OR

Choose Jump to Link from the Links menu.

OR

Double-click the object..

To break a link:
1. Select the linked object.

2. Choose Break Link from the Links menu.

Related Topics

The Tool Bar
Using Chart Windows



Exit
Choose Exit to quit Flow Charting 4. If you have made any changes to flowcharts, you will be prompted to
save them before the application quits.



Selection Tool Button

This button is located on the Tool Bar.



Shape Tool Button

This button is located on the Tool Bar.



Line Tool Button

This button is located on the Tool Bar.



Text Tool Button

This button is located on the Tool Bar.



Template Button

This button is located on the Tool Bar.



ShapeManager

The ShapeManager is used to view or change attributes of shapes.



LineManager

The LineManager is used to view or change attributes of lines.



TextManager

The TextManager is used to view or change attributes of text.



Tool Manager Button

This button appears on the Tool Bar when more than one type of object is selected. Click the button to 
display different tool managers.



Menu Commands

A menu bar appears at the top of the chart window. For more information about the commands on a 
menu, click one of following menus:

File
Edit
Actions
Links 
Windows 
Help
Template

Note: You can also use keyboard accelerators to select many menu commands. For more information, 
click the Menu Command Shortcuts topic.



File Menu Commands

The following commands appear on the File menu. Click a menu command for more information.

File Menu
New
Open...
Close
Save
Save As...
Chart setup...
Print...
Program Preferences...
Exit



Edit Menu Commands

The following commands appear on the Edit menu. Click a menu command for more information.

Edit Menu
Undo/Redo
Cut
Copy
Paste
Delete
Duplicate
Select All
Copy to File
Paste From File



Actions Menu Commands

The following commands appear on the Actions menu. Click a file command for more information.

Actions Menu
Bring to Front
Send to Back
Align
Clear Shape Text
Reshape Lines
Connect Adjoining Lines
Disconnect Lines
Scale Selection - 80%
Scale Selection - 125%



Links Menu Commands

The following commands appear on the Links menu. Click a menu command for more information.

Links Menu
Create Link
Break Link
Jump to Link



Window Menu Commands

The following commands appear on the Windows menu. Click a menu command for more information.

Windows Menu
Tile
Cascade
Arrange Icons
Center Window
Zoom
List of Files



Keyboard Reference

Menu Command Shortcuts
Mouse Shortcuts



Help Menu Commands

The following commands appear on the Help menu. Click a menu command for more information.

Help Menu
Index
Menu Reference
Keyboard Reference
Screen Reference
Product Support
About



Template Menu Commands

The following commands appear on the Template menu. Click a template command for more information. 
Click the Using Templates topic for more information.

Template Menu
Open
New
Edit
About
List of Templates



About

Displays the About box with information about the currently open template. You type the template 
information when creating or editing a template. Click OK to close the About box. For more information, 
click the Using Templates topic.



Menu Command Shortcuts

Use the following menu shortcut keys to execute menu commands. The plus sign means to press both 
keyboard keys at the same time to execute the menu command.

Tip: Choose Print Topic from the Help File menu to print the information on menu command shortcut 
keys.

Menu Command Shortcut Keys
Bring to Front F8
Center Window Ctrl+W
Close Ctrl+F4
Copy Ctrl+C
Copy to File F11, Ctrl+click Copy button
Create Link Ctrl+Double-click
Cut Ctrl+X
Delete Del, Ctrl+click Cut button
Duplicate Ctrl+D
Exit Ctrl+F4
Help F1
Jump to Link Double-click
Open Ctrl+O
Paste Ctrl+V
Paste from File Shift+F11, Ctrl+click Paste button
Print Ctrl+P
Save Ctrl+S
Save As Ctrl+click Save button
Select All Ctrl+/
Send to Back Shift+F8
Undo Ctrl+Z
Zoom In Gray +
Zoom Out Gray -
Zoom Entire Chart Gray *, Ctrl+click Zoom Out button
Zoom Current Page Ctrl+.
Zoom Actual Size Ctrl+=, Ctrl+click Zoom In button

Note: Gray refers to a key on the number keypad on the right side of your keyboard (on most keyboards, 
these symbol keys are gray colored). For example, Gray + means press the gray plus key on the number 
keypad.



Chart Titles

A chart title appears at the top of each window and displays the file name and location of the chart. Until a
chart is saved to a different name, each chart window is called Untitled, followed by a number. For 
example, the first new chart window is called Untitled #1. If a chart window is maximized, its title will 
appear in the Flow Charting 4 application window title bar.



Click

Click means to press the left (or primary) mouse button down once.



Squared Line

A squared line consists of two or more points. It can be a straight line, or it can bend to follow the path of 
points that you specify for the line. Each bend in the line, however, will be constrained to a 90 degree 
angle with a squared-off corner that looks like the corner of a rectangle.



Curved Line

A curved line is a smooth line with a maximum of four points. The first and last point control the placement
of the line, and the other points control the curvature.



Free-Angle Line

A free-angle line consists of two or more points, but there are no constraints on where you place the 
points or the angles of the bends in the line.



<filename> is already open. Please choose another name.
You tried to rename a chart to the name of a chart already open.



<filename> is an invalid file. Overwrite?
<filename> is not a Flow Charting 4 file.    Are you sure you want to overwrite it?



<filename 1> is corrupt.    The file has been saved as <filename 2>.
<filename 1> was corrupted while writing it.    However, your file has been successfully saved with
the name <filename 2>.



A template must be loaded. If you choose to cancel, the application must exit.
Flow Charting 4 cannot operate without a template.    Open a template, or cancel to exit Flow 
Charting 4.



Access denied to the file, <filename>.
Flow Charting 4 is not able to modify the file.    Choose a different filename.



Cannot create temporary file. Operation aborted.
Flow Charting 4 was trying to leave your original file intact, but it could not create a temporary file.
Check your disk free space or the number of files in the specified directory.



Cannot open linked file. Remove the link?
The linked file no longer exists.    Do not remove the link if you can replace the file; otherwise, 
remove the link and create a new one.



Conversion error.    Operation aborted.
The file cannot be converted to a new Flow Charting 4 flowchart.    It may be corrupt.



Disk operation failed.
The read or write operation failed.    Check the drive door or media.



Do you want to leave the data on the clipboard?
You copied information to the clipboard that may use unnecessary memory.    Do you need that 
information?



Empty charts cannot be printed.
You are attempting to print a blank chart.



Empty charts cannot be saved.
You are attempting to save a blank chart.



Internal Error. Combo box error.
Contact Patton & Patton technical support.



Internal Error. Could not delete shape: <shape name>.
Contact Patton & Patton technical support.



Internal Error. Could not find shape: <shape name>.
Contact Patton & Patton technical support.



Internal Error. Not enough space to add item.
Contact Patton & Patton technical support.



Internal Error. Unable to create Status Tray.
Contact Patton & Patton technical support.



Internal Error. Undefined shape.
Contact Patton & Patton technical support.



Invalid file.
The file is not a valid Flow Charting file.    It may be corrupt.



Invalid point size. Valid sizes are 4 to 127.
Flow Charting 4 can only display point sizes in this range.



Not enough memory to complete the operation.
Try to close other applications to get more memory, or restart Windows and try again.



One or more of the margins are too large. Use these margins?
Your chart setup margins are too large for the current printer and paper size.    Do you want to edit
the chart anyway?



One or more of the requested margins are too small for the current printer.
You requested margins to be smaller than that allowed by your printer. 

If you click the Use requested button, you can use your margins anyway (however, the chart will 
not print with the same page breaks you had while editing).
If you click the Use minimum button, the margins will be reset to the minimum margins allowed 
by the printer.
If you click the Cancel button, you can edit the margins.



Please close a window before opening another.
Flow Charting 4 supports 9 open windows only.



Read error.
The file may be corrupt.



Save settings, and use as default for all new charts?
If you agree, all new charts will use these settings.



The chart, <filename>, is in use by <person>.
Contact that person or try again later.



The chart, <filename>, is in use by <person>.    Open as Untitled?
You cannot edit the original file.    If you want to open it as Untitled you can at least view it.



The chart was formatted for a <device name>, but that device is not available.    
Resetting to <default printer>.

The page perforations, margins, and text layout were formatted for a different device that is no longer 
available.    When you accept the print or chart setup dialog the new default printer will be used to format 
the document.    Save the chart if you want to make the new formatting permanent.



The default printer is no longer <device name>. Reformatting for new default 
printer, <default printer>.

The chart was designed, formatted, and saved with a different default printer. Reformatting for a new 
default printer may change the location of page breaks.    Use chart setup to choose a specific printer if you 
do not want to use the new default printer.



The disk is full.
Try to delete unnecessary files or choose another destination.



The disk is write-protected.
Remove the write-protect tab (or switch) and try again, or choose another destination.



The file, <filename>, already exists. Overwrite?
Do you want to delete the other file with the same name and overwrite it?



The file, <filename>, is read-only. Open as Untitled?
You cannot edit a read-only file, but you can view it as a new, untitled file.



The file, <filename>, was not found.
Check your spelling or drive and directory location.



The height must be in the range 1..64
You must specify the number of rows for your template.



The pasted item is too large to fit on the chart.
Increase your chart canvas size by using Chart Setup.



The template has been modified.    Would you like to save it?
You canceled the Template Organizer after you had modified it.



The width must be in the range 1..64
You must specify the number of columns for your template.



There was an error opening the template: <filename>
The template may be corrupt or not a valid Flow Charting 4 template.



This chart appears to be already open on a different path.
You tried to read a file that is already open with a different name.



This file appears to be a GEM file.
GEM files have an extension of CHT also.    Flow Charting 4 cannot convert this file.



Too many files are open. Operation aborted.
Flow Charting 4 could not open the file because too many files are already open.



Unable to delete corner points on squared lines.
You can delete end points, but not corner points.    Try moving the point instead.



Unable to open the file.
There was an error opening the file.    Check your access rights if the file was on a network drive.



Unknown file error reported by Windows.
There was an error reading or writing a file. Try a different name or device.



Unrecognized drive.
An invalid drive letter was specified in a filename.



Unsupported file version.
Flow Charting 4 cannot read the file because its version is too new or too old.



Would you like to save changes made to <filename>
If you choose YES, the file will be saved.    If you choose NO, the chart will not be saved and the 
operation will continue (quitting or closing).    If you choose CANCEL, the operation will be 
canceled and the file will not be saved.



Write error.
The file was not written successfully.    Try specifying a different location.



Write error. <filename 1> has been saved as <filename 2>.
The file, filename 1, had to renamed because of a disk error.    Its new name is provided.



Your printer driver version is not supported.
Contact Microsoft or your printer manufacturer for a new software driver.



Product Support Information

Before you call technical support, do the following:

1. Check the Flow Charting 4 User's Guide for answers to any questions you might have. This manual is
your best source of information.

2. Check the Readme file for Flow Charting 4 information that became available too late to be printed in 
the manual.

3. For information on a specific error message, press F1 when the error message is displayed.

If you still cannot find the answer to your questions, you can contact Patton & Patton technical support at:

Phone: (408) 778-6557
Fax: (408) 778-9972
Hours: 9 A.M. to 5 P.M. Pacific Time

24 hour BBS: (408) 778-9697 (300-9600 baud)

You can also write:

Patton & Patton Technical Support
485 Cochrane Circle
Morgan Hill, CA 95037



Endcap Configuration Dialog Box
The Endcap Configuration dialog box allows you to set the endcaps that appear in the LineManager.

Click the dialog box for information about a specific option.



List of Current Endcaps
Displays the current list of endcaps. You can change the endcaps that appear on the LineManager 
Endcap drop-down lists by adding, removing, or reordering the endcaps on the current list.



Move Up Button
Click the Move Up button to move the selected endcap up one position on the list of current endcaps.



Hide Button
Click the Hide button to move a selected endcap from the list of current endcaps to the list of hidden 
endcaps. A hidden endcap does not appear on the LineManager Endcap drop-down lists.



List of Hidden Endcaps
Displays the list of hidden endcaps. A hidden endcap does not appear on the LineManager Endcap drop-
down lists.



Show Button
Click the Show button to move the selected endcap from the hidden list to the current list. Endcaps in the 
current list will be available to the LineManager.



Help Button
Click the Help button to display on-line help about the dialog box.



Move Down Button
Click the Move Down button to move the selected endcap down one position on the list of current 
endcaps.



Template Organizer Dialog Box
If you want to organize your shapes into job-specific templates, the TemplateOrganizer can add shapes 
from any available template, or remove shapes you do not need. You can create new templates, or modify
existing ones.

Click the dialog box for information about a specific option.



Title Text Box
Type a title for the new template. The title appears in the title bar at the top of the template.

Note: The Width text box determines how many shapes appear in each row of the template. If the 
template is narrow, keep the title short.



Author Text Box
Type the name of the person creating the new template. Although the author name is not required, it can 
be helpful to know who created the template. To display the author name, choose About from the 
Template menu.



Description Text Box
Type a brief description of the symbols in the new template. Although a description is not required, it can 
be used to remind you why the template was created. To display the template description, choose About 
from the Template menu.



Version Text Box
Type the version number of the new template. Although the version number is not required, it can be used
to distinguish between similar templates. To display the version number, choose About from the Template 
menu.



Width Text Box
A width number is required for all templates and determines how many shapes appear in each row of the 
template. Type a number from 1 to 64 in the Width text box.



Height Text Box
A height number is required for all templates and determines how many shapes appear in each column of
the template. Type a number from 1 to 64 in the Height text box.



Import Template Box
Displays the symbols that can be imported into the template being edited. After selecting a shape from the
imported template, click Insert or Append.



Import Button
Click Import to display symbols from another template. After you click Import, the Import dialog box 
appears, and, you can select a template to open. For more information on opening a template, see the 
Opening a Template topic.



Current Box
Displays the shapes that will be saved with the current template. You select shapes to add by selecting 
them in the Import Template box.



Insert Button
Click Insert to add a selected shape from the Import Template box. The shape appears before the current 
shape in the Current box.



Append Button
Click Append to add a selected shape from the Import Template box to the new template. The shape 
appears at the end of the list in the Current box.



Remove Button
Click to remove a selected shape from the Current box.



Cancel Button
Click Cancel to undo any changes and close the dialog box.



OK Button
Click OK to accept the changes and close the dialog box.



Save Template Dialog Box
The Save Template dialog box allows you to name and save a template file.

Click the dialog box for more information on a specific option.



File Name Text Box
Displays the name of the current file. Each file name can be up to eight characters long followed, by a 
three character file extension.



List of Files
Displays the list of the current directory files that match the file type shown in the List Files of Type drop-
down list. Click a file to have the name appear in the File Name text box.



List Files of Type Drop-Down List
Displays the current file type. To change the file type, select another file type from the drop-down list.



Drives Drop-down List
Lists the available drives. To change drives, select another drive from the drop-down list.



List of Directories
Lists the current directory. The directory name appears above the list and is shown in the list by an open 
folder. To open another directory, double-click the directory folder.



Program Preferences Dialog Box
Program preferences are settings that help to determine how Flow Charting 4 works.

Click the dialog box for information on a specific option.



User name
The user name is the name of the licensed owner of Flow Charting 4. The user name also identifies the 
person who is working with a chart. This information is especially useful if you are storing Flow Charting 4 
chart files on a network where they can be accessed by more than one person. If you try to open a flow 
charting file that is being used by another person, that user's name appears in warning.



Lines
The lines options set the attributes of the lines in your flowchart. Select from the following options:

* Stick to objects: to cause lines attached to an object to remain attached, or stuck, to that object when 
the object moves. When moving objects, hold the Alt key (or the A key) down to temporarily reverse 
the state of this switch. See Moving Objects.

Note: Lines are considered attached to an object only when you specifically attach them. It is possible
to have a line touching another object, but not have it attached. Attached lines are indicated by 
circular handles at the end points when the line is selected (regardless of the state of this switch). See
Connecting Lines to Other Objects.

* Snap to objects: to cause any line that ends near a shape to snap automatically to the outline of that 
shape. When creating or editing a line, press the Shift key to toggle the state of a line between 
snapping and not snapping to objects.

* Click Choose Endcaps to select the type of endcaps you want displayed in the LineManager.



Text
Select Overwrite blocks to replace highlighted text with any new text you type.



Grid
Select Snap to grid, and each object you insert in a chart automatically aligns to an invisible grid. This grid
makes it easier to align objects. When creating, moving, or resizing an object, hold down the Ctrl key to 
toggle temporarily this setting between snapping and not snapping to the grid.



Units of Measure
Select to display either English or metric measurements on the chart ruler.



Resizing
Select Reflective resizing to mirror a resizing action. For example, when Reflective sizing is selected, and 
you drag the right side of a rectangle one inch to the right, the left side of the rectangle will automatically 
move 1 inch in the opposite direction. When resizing an object, press the Alt key (or the A key) to toggle 
this setting between reflective and normal resizing.



Windows
The Windows options change the appearance of your chart. Select from the following options:

* Show rulers: to display a ruler along the top and left side of a chart window.

* Show perforations: to display perforations (dotted lines) on each flowchart page.

* Show status line: to display information at the bottom of the application window that identifies the 
current state of the program or gives you instructions on how to use a selected option.

* Sensible scroll: to make scrolling faster, this setting creates a sketch of your chart while you are 
scrolling. Once you stop scrolling, the complete chart appears. If your computer has a slow 
processing speed, this setting makes it much faster to scroll through a flowchart.



Use Defaults
Click Use Defaults to reset the dialog box to the factory default settings.



Copy to File Dialog Box
The Copy to File dialog box allows you to copy selected objects to disk so they can be used repeatedly in 
all of your flowcharts. Files created this way have an extension of GFI (graphic flowchart image).

Click the dialog box for more information on a specific option.



Paste from File Dialog Box
The Paste from File dialog box allows you to paste objects from disk so they can be used repeatedly in all
of your flowcharts. Flow Charting 4 uses an extension of GFI (graphic flowchart image) for these types of 
files.

Click the dialog box for more information on a specific option.



Open Template Dialog Box
The Open Template dialog box allows you to open another template.

Click the dialog box for more information on a specific option.



Customize Colors Dialog Box
The Customize Colors dialog box allows you to change the colors that appear on the tool manager color 
palettes. Double-click a color in one of the tool managers to choose new colors for the color palette.

Click the dialog box for more information on a specific option.



Color Palette
Color palettes are used in the tool managers to let you apply a color to an object. Each color box can be 
set to one of the master colors.

Note: A square with an X through it means the color is transparent and can be used to prevent a shape 
from being filled.



Master Colors
Displays the color choices that you can apply to a square on the Color Palette.

Note: A square with an X through it means the color is transparent.



Open Dialog Box
The Open dialog box allows you to open saved flowchart files.

Click the dialog box for more information on a specific option.



Print Dialog Box
The Print dialog box allows you to print a flowchart to a Windows-compatible printer. The print dialog that 
appears depends upon the type of printer connected to your computer. The following illustration is a Print 
dialog for a typical laser printer.

Click the dialog box for more information on a specific option.



Printer Name
Displays the name of the currently selected printer and the printer port to which it is connected.



Print Range
Allows you to specify the pages to print from the current flowchart. You can select from the following 
options:

* All: to print all the pages in the flowchart.

* Selection: to print the selected objects in your flowchart.

* Pages: to specify a range of pages to print in your flowchart. If you select this option, type the page 
range in the From and To number boxes.

Note: The page orientation affects the page numbering sequence. In portrait mode, pages are 
counted from top to bottom and then left to right. In landscape mode, pages are counted left to right 
and then top to bottom.



Print Quality Drop-Down List
Depending upon the type of printer you are using, the options in the Print Quality drop-down list vary.



Print to File
Select this option to print the flowchart to a file rather than to the printer. A dialog box appears, allowing 
you to choose a file name. The file created will be printer-specific, and should only be copied to your 
printer. It will not be readable by Flow Charting 4.



Print Blank Pages
Select this option to print the blank pages in your chart. You select the number of pages in your flowchart 
by choosing Chart Setup from the File menu. This option is useful for fan-fold paper to print your charts in 
strips that can be joined together.



Collate Copies
Select this option to collate copies, or make sure the pages are in the correct order.



Setup Button
Click Setup to display the Print Setup dialog box where you can change printers, the page orientation of 
the flowchart (either landscape or portrait), or the paper size of the flowchart. These options can also be 
set by choosing Chart Setup from the File menu.

Note: Any changes you make to the printer or chart layout will be temporary only. The options will not 
affect the current chart. If you want to make the changes permanent, see Setting Chart Options.



Copies
Type the number of copies you want to print.



Save As Dialog Box
The Save As dialog box allows you to save or rename a chart file.

Click the dialog box for more information on a specific option.



Chart Setup Dialog Box
The Chart Setup dialog box allows you to specify the page settings for your flowchart.

Click the dialog box for more information on a specific option.



Printer
Displays the printer settings for the current chart. The settings include the printer associated with the 
chart, the orientation of the chart, and the paper size used by the chart. 

To change the printer settings:
1. Click the Change button.

A Print Setup dialog box appears that lets you select different settings. See the topic, Print Setup 
Dialog for more information.



Margins
Displays the margins used for each page of a flowchart. To change the margin settings, type a number 
into the Top, Bottom, Right, or Left number box. The numbers you type are specified in inches, using 
decimal notation. If you want to specify the numbers in millimeters, append the characters, mm.

For instance, a margin of 1/4 of an inch would be specified as

0.25

 or

6 mm

Note: Each type of printer has different minimum margin areas. If you attempt to set the margins below 
these minimum values, your chart may not print with the same page breaks that you saw while editing the
chart. If your values are too small, you will be given the choice of accepting them or resetting to the 
minimum margins allowed by the printer.



Canvas Size
Displays the number of pages in your flowchart. Click the Canvas Size display box to change the number 
of pages in your flowchart. You can also drag the edges of the selected pages in the display box to 
change the number of pages in your flowchart.

Note: The page orientation affects the page numbering sequence. In portrait mode, pages are counted 
from top to bottom and then left to right. In landscape mode, pages are counted left to right and then top 
to bottom.



Save Settings
Click this button to save the settings of this dialog box as the default settings for all new charts. This is 
much like a snapshot command because the settings are recorded and used for all new charts that you 
create.



Print Setup Dialog
Click the dialog box for more information on a specific option.



Default Printer or Specific Printer
If you choose Default Printer, the printer designated as default by the Windows Control Panel, will be 
used to format and print the chart. Note that changing the default printer via the Control Panel can change
a chart's page size and therefore the page breaks. You should only use the Default Printer setting when 
you do not care about page breaks changing, or you do not switch the default printer very often.

If you choose Specific Printer, and choose a printer from the drop-down list, the chart will always be 
associated and printed using that printer, even if the default printer changes.



Options
Controls printer-specific options. See the note in the Paper controls about custom paper sizes.



Orientation
Select either portrait or landscape page orientation. The page orientation affects the page numbering 
sequence. In portrait mode, pages are counted from top to bottom and then left to right. In landscape 
mode, pages are counted left to right and then top to bottom.



Paper
Contains options that let you select the paper size and paper tray in your printer. Select a paper size from 
the Size drop-down list. Select a specific paper tray from the Source drop-down list. For more information 
on these options, refer to your printer or Windows documentation.

Note: If you choose a custom paper size, you must specify a width and a height of the paper. Depending 
on the printer driver, the width and height may be available by clicking the Options button, or they may be 
available from the Printers control icon in the Control Panel (click the Setup button there).



CreateLink Dialog Box
The CreateLink dialog box allows you to link an object to a page in the same flowchart or another 
flowchart.

Click the dialog box for more information on a specific option.



Page #
You can link an object to a page in a flowchart. Type the number of the page to which you want to link the 
selected object.




